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1 Basic concepts
An operating system (OS) is the software that manages the sharing of the resources of a computer and
provides programmers with an interface used to access those resources. An operating system processes
system data and user input, and responds by allocating and managing tasks and internal system resources as
a service to users and programs of the system. At the foundation of all system software, an operating system
performs basic tasks such as controlling and allocating memory, prioritizing system requests, controlling
input and output devices, facilitating networking and managing le systems. Most operating systems come
with an application that provides a user interface for managing the operating system, such as a command
line interpreter or graphical user interface. The operating system forms a platform for other system software
and for application software.
The most commonly-used contemporary desktop operating system is Microsoft Windows, with Mac OS
X also being well-known. Linux and the BSD are popular Unix-like systems.
The operating system is the rst thing loaded onto the computer  without the operating system, a
computer is useless. In detail, important services that an operating system provides are:

• Create Interface between you and your computer
• Manage the le system includes directories, folders, les
•
•
•
•

Has a set of commands that allow for manipulation of the le system: sort, delete, copy, etc.
Perform input and output on a variety of devices
Allocate Resources
Manage the running systems

Categorization of operating systems
All desktop and laptop computers have operating systems. Operating systems are categorized based on
the types of computers they control and the sort of applications they support.

•
•
•
•

Single-user, single task
Single-user, multi-tasking
Multi-user
Real-time operating system
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1.1 File
A computer le is a block of arbitrary information, or resource for storing information, which is available
to a computer program and is usually based on some kind of durable storage. A le is durable in the sense
that it remains available for programs to use after the current program has nished. Computer les can
be considered as the modern counterpart of paper documents which traditionally were kept in oces' and
libraries' les, which are the source of the term.
A lename is a special kind of string used to uniquely identify a le stored on the le system of a computer.
Depending on the operating system, such a name may also identify a directory. Dierent operating systems
impose dierent restrictions regarding length and allowed characters on lenames.
Many operating systems, including MS-DOS, Microsoft Windows, allow a lename extension that consists
of one or more characters following the last period in the lename, thus dividing the lename into two parts:
the base name (the primary lename) and the extension (usually indicating the le type associated with a
certain le format). The base name and the extension are separated by a dot.
Commonly, the extension indicates the content type of the le, for example,
exe: executable le, txt : text le, pas : pascal source le, cpp : C++ source le. . .
In MS-DOS, Microsoft Windows, you can use wildcards ? and *. ? marks a single character while *
Marks any sequence of characters.
Example *.pas : all pascal source les of the current directory , possibly t1.pas, book.pas. . .
b*.cpp : all C++ source les beginning with b.

1.2 File Management
Structures of Disks

Floppy disk can be single-sided or double-sided. Data is stored on a disk in circular tracks. Tracks are
numbered 0, 1. . . Each track is broken up into arcs called sectors. Each sector stores a xed amount of
data. The typical formatting of these media provide space for 512 bytes (for magnetic disks) or 2048 bytes
(for optical discs) of user-accessible data per sector.
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Track, sector, cluster

Formatting (initializing) a disk

Disk formatting is the process of preparing a hard disk or other storage medium for use, including setting
up an empty le system. Formatting a disk includes the following tasks:

•
•
•
•

Determines the sector size and placement.
Slices the disk into sectors by writing codes on the disk.
Locates bad spots on the disk, locks it out to prevent the bad spot from being used.
Side number, track number, sector number Þ address : locates where on the disk the computer will
store the data.

Computer le system

In computing, a le system is a method for storing and organizing computer les and the data they
contain to make it easy to nd and access them. File systems may use a data storage device such as a hard
disk or CD-ROM and involve maintaining the physical location of the les, or they may be virtual and exist
only as an access method for virtual data.
More formally, a le system is a set of abstract data types that are implemented for the storage, hierarchical organization, manipulation, navigation, access, and retrieval of data.
A typical le system may contain thousands (or even hundreds of thousands) of directories. Directory
(catalog, or folder) is an entity in a le system which contains a group of les and/or other directories.Files are
kept organized by storing related les in the same directory. A directory contained inside another directory
is called a subdirectory of that directory. Together, the directories form a hierarchy, or tree structure.

http://cnx.org/content/m30793/1.1/

Connexions module: m30793

4

This media object is a downloadable le. Please view or download it at
<http://cnx.org/content/m30793/1.1/51.PNG>

Figure 2:

Directory tree

The rst or top-most directory in a hierarchy is the root directory (symbolized by the back slash \)
The current directory is the directory in which a user is working at a given time.

Full name of a le

A full lename includes one or more of these components

•
•
•
•

Drive (e.g., C:)
Directory (or path) le
Base name of the le
Extension

An operating system includes several les, for instant, MS-DOS includes MSDOS.SYS, IO.SYS, COMMAND.COM . . .

2 Some Common Operating Systems
2.1 MS-DOS
MS-DOS (short for Microsoft Disk Operating System) is an operating system commercialized by Microsoft.
It was the most commonly used member of the DOS family of operating systems and was the dominant
operating system for the PC compatible platform during the 1980s. It has gradually been replaced on
consumer desktop computers by various generations of the Windows operating system.
MS-DOS employs a command line interface and a batch scripting facility via its command interpreter,
COMMAND.COM.
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The MS-DOS 6.22 command line interface

2.2 Microsoft Windows
Microsoft Windows is the name of several families of software operating systems by Microsoft. Microsoft
Windows interest in graphical user interfaces (GUI)
MsWindows are introduced in detail in the next section.

2.3 The Most Common Commands of an Operating Systems
Every operating system need a system of command for managing les and disks. Commonly used types are
:

• File management : copy, delete, rename, type a le.
• Directories management: create, remove, copy directories.
• Disk management : disk copy, disk format.

3 Microsoft Windows
3.1 Brief History of Microsoft Windows
In 1983 Microsoft announced its development of Windows, a graphical user interface (GUI) for its own
operating system. Windows 3.0, released in 1990, was a complete overhaul of the Windows environment
with the capability to address memory beyond 640K and a much more powerful user interface.
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Windows for Workgroups 3.1 was the rst integrated Windows and networking package oered by Microsoft.Windows for Workgroups also includes two additional applications: Microsoft Mail, a network mail
package, and Schedule+, a workgroup scheduler.
Windows 95, released in August of 1995. A 32-bit system providing full pre-emptive multitasking,
advanced le systems, threading, networking and more.Also includes a completely revised user interface.
Windows 98, released in June of 1998. Integrated Web Browsing gives your desktop a browser-like
interface.
Windows 2000 provides an impressive platform of Internet, intranet, extranet, and management applications that integrate tightly with Active Directory.
In September 2000 Microsoft released Windows Me, short for Millennium Edition, which is aimed at the
home user. The Me operating system boasts some enhanced multimedia features, such as an automated
video editor and improved Internet plumbing.
Windows XP-Microsoft ocially launches it on October 25th. 2001.XP is a whole new kind of Windows
for consumers. Under the hood, it contains the 32-bit kernel and driver set from Windows NT and Windows
2000. Naturally it has tons of new features that no previous version of Windows has.
Windows Vista is a line of graphical operating systems used on personal computers, including home and
business desktops, notebook computers, Tablet PCs, and media centersWindows Vista contains hundreds
of new and reworked features; some of the most signicant include an updated graphical user interface and
visual style dubbed Windows Aero, improved searching features, new multimedia creation tools such as
Windows DVD Maker, and completely redesigned networking, audio, print, and display sub-systems.
Originally developed as a part of its eort to introduce Windows NT to the workstation market, Microsoft
released Windows NT 4.0, which features the new Windows 95 interface on top of the Windows NT kernel.
Windows NT (New Technology) is a family of operating systems produced by Microsoft, the rst version
of which was released in July 1993. It was originally designed to be a powerful high-level-language-based,
processor-independent, multiprocessing, multiuser operating system with features comparable to Unix. It
was intended to complement consumer versions of Windows that were based on MS-DOS. NT was the rst
fully 32-bit version of Windows, whereas its consumer-oriented counterparts, Windows 3.1x and Windows 9x,
were 16-bit/32-bit hybrids. Windows 2000, Windows XP, Windows Server 2003, Windows Vista, Windows
Server 2008 (beta), and Windows Home Server are based upon the Windows NT system, although they are
not branded as Windows NT.
Windows XP is the most popular version of Microsoft Windows. Windows provides a graphical interface,
through which you can run programs, manage les, connect to the internet, and perform many other task
as well.

3.2 How to start and exit from Windows XP
3.2.1 Starting Windows XP
Windows XP starts automatically when you turn on your computer. Depending on the way your PC is
currently set up, you may be prompted to select a user account when you start up your PC. Windows will
display a welcome screen, from which you click your user name and indicate who you are by entering your
password.
Once Windows XP has initialized, the following screen will appear.
Each user has his own ideas about what constitutes attractive screen colors, important shortcut to place
on the desktop etc. This combination can be saved as user prole and Windows remembers all the setting
and preferences.
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Figure 4

3.2.2 Shutting down Windows XP
When you nished using your PC, you shouldn't turn o the power because that could cause later problems
in Windows. Instead, you should use the Shut Down command on the Start menu (or press Ctrl+Esc if the
Start menu is invisible). This approach ensure that Windows shuts down in an orderly way that closes all
opened les and saves your work in any open program.
When shutting down, you have two options: Turn O and Restart. If you are probably to be away from
the computer, you will probably want to turn it o. If the computer is acting strangely and you want to
start fresh, you will want to refresh.
If for some reason, the computer is not ready to shut down , the computer will remind you in dialog
boxes.

3.3 Basic Terms and Operations
The Icons

On the desktop we have icons that allow us to open the corresponding program.
For example, by clicking on the icon

The windows
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All the windows have the same structure;The window above is the one that opens when you click on My
Computer. Its structure is very similar to the others.

Figure 5

All the windows are formed by:

• The title bar contains the name of the program you are working with and in some cases the name of the
opened document also appears. In the top right corner we can nd the minimize, maximize/restore,
and close buttons.
• The minimize
task bar.

button shrinks the window it turns it into a button located in the WindowsXP

• The maximize

amplies the size of the window to the whole screen.

• The restore button
• The close button
http://cnx.org/content/m30793/1.1/
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closes the window. If we have modied the document, we are asked if we want
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to save the changes before closing.

The dialog boxes

The dialog box is a small window-like box that opens after an operation has been selected. In it, you
select options and settings to tailor the operation before it proceeds.

Figure 6

Text box : a control in which a user can enter texts (or numbers).
List box : a box that contains a list of selectable items. In some instances, you select an arrow button

on the right of the box in order to display the selectable items.
Combo box : a combination of a drop-down list or list box and a single-line textbox, allowing the user
either to type a value directly into the control or choose from the list of existing options.
Check box : a control that permits the user to make single selection or multiple selections from a
number of options. Normally, check boxes are shown on the screen as a square box that can contain white
space (for false) or a tick mark or X (for true).
Command Button: A control used to initiate an action. The most common buttons are :

•
•
•
•
•

OK
Close
Cancel
Apply
Default
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3.4 Using a computer mouse
Use the mouse to interact with items on your screen as you would use your hands to interact with objects
in the physical world. You can move objects, open them, change them, or throw them away, among other
things.
A mouse has a primary and secondary mouse button. Use the primary mouse button to select and click
items, position the cursor in a document, and drag items.
Use the secondary mouse button to display a menu of tasks or options that change depending on where
you click. This menu is useful for completing tasks quickly. Clicking the secondary mouse button is called
right-clicking.
The primary mouse button is normally the left button on the mouse. On a trackball, the primary mouse
button is normally the lower button.
You can reverse the buttons and use the right mouse button as the primary button.Most mice now include
a wheel that helps you to scroll through documents more easily.

Pointing

Pointing at items on the screen is the most basic mouse function. When instructions tell you to point
your mouse at something, move your mouse on your desk until the mouse pointer is pointing at the object
on the screen you need to select.

Clicking

After you have pointed your mouse at an item, you can click on the item to select it.

Double clicking

To double-click an item, point at the item and press your primary button twice quickly without moving
the mouse. Double-clicking allows two dierent actions to be associated with the same mouse button.
Often, single-clicking selects (or highlights) an object, while a double-click executes that object, but this is
not universal.

Drag and drop

to move the item from one place to another using the mouse. Point at the item you need to move, and
single click on it. Instead of releasing the mouse button after clicking, hold it down, and move your mouse
to where you want to move the item. Release the mouse button to drop the item into place.

Right clicking

Right-clicking an item usually brings up a menu of actions you can take with the item. To right-click,
point at an item and press the secondary (right) button on your mouse.

3.5 The Control Panel
Control Panel allows users to view and manipulate basic system settings and controls, such as adding
hardware, adding and removing software, controlling user accounts, and changing accessibility options.
To start the Control Panel, from the Start menu, click on Control Panel. Here is the Control Panel
window:

http://cnx.org/content/m30793/1.1/
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Figure 7

.
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3.5.1 Conguring the Screen
Conguring the screen is important because sometimes we spend many hours in front of the screen, so we
hope it can be the most comfortable as possible.
Open the Display Tool (or right-click somewhere that has no icons on the desktop and select the option
Properties from the shortcut menu that is displayed. The Display properties window will appear where we
can change the conguration parameters.
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Figure 8

Change the background or wallpaper,
Click on the tab labeled Desktop and choose a new background or wallpaper from the list that appears
at the bottom left corner. It is also possible to have another image that does not appear on the list as
background. Click on Browse... and look for the image you want as long as the format is compatible. For

http://cnx.org/content/m30793/1.1/
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example .bmp, .jpg, .gif.Once the image and type of view have been selected Click OK.

3.5.2 The screensaver
Sometimes the computer remains inactive a few minutes. It is recommended to have a screensaver to avoid
having a still image on the screen too long because this can damage the monitor.
From the list, choose the screensaver you like best; a small preview is shown above.
You can modify the time it takes for the screensaver to appear by adjusting the time on Wait.

3.5.3 Conguring the Mouse
The mouse is a tool that is used constantly and it is recommendable to have it set up to our needs as well
as possible. In the following page we show you how to set it up to your own needs.

The Buttons

On the Buttons tab you can adjust the set up of the mouse to suit your needs.If you are left handed.
WindowsXP allows you to change the conguration of the buttons so that the right button realizes these
functions.
We can also adjust the Double-click speed for a slower or a faster double-click.

The pointer

On the Pointers tab we can choose the type of pointer the mouse is to have when it moves, when it is
busy, when it is used, etc.

3.5.4 Adding or removing Programs
• Click on the Start button and choose Control Panel
• Click on Add or Remove Programs option, a window will display with the three basic options shown
on the left side of the picture as it appears below. Then click on Add New Programs.The window will
appear where we can change the conguration parameters.
• Follow the instruction
• The Add or Remove Programs window will appear where we can add, change or remove programs
following the instructions..

http://cnx.org/content/m30793/1.1/
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Figure 9

3.5.5 Changing the Regional and Language Options
You can use the Regional and Language Options tool in Control Panel to customize the way Windows
handles dates, times, currency values, and numbers.
To open the Regional and Language Options tool

• Click Start, and then click Control Panel.
• Click Date, Time, Language, and Regional Options, and then click Regional and Language Options.
• To change one or more of the individual settings, click Customize.

http://cnx.org/content/m30793/1.1/
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Figure 10

To Change the Date In the Customize Regional Options dialog box, click the Date tab to specify any changes
you want to make to the short date and the long date.
To Change the Time In the Customize Regional Options dialog box, click the Time tab to specify any
changes you want to make.
To Change the Currency Value Display
In the Customize Regional Options dialog box, click the Currency tab to specify any changes you want
to make. You can change the currency symbol, the formats used for positive or negative amounts, and the
punctuation marks.
To Change the Number Display
In the Customize Regional Options dialog box, click the Numbers tab to specify any changes you want
to make. You can change the decimal symbol and list separator, the format used for negative numbers and
leading zeros, and the measurement system (U.S. or metric).
http://cnx.org/content/m30793/1.1/
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3.5.6 Add a printer
• Click on Printer and Faxes
• Click on Add a Printer, follow the instruction of the Add Printer Wizard

3.5.7 Delete a printer
• Click on Printer and Faxes
• Click on the printer you wish to delete.
• Press your Delete key to delete the printer.

3.6 The Windows Explorer
The Explorer is an indispensable tool in an operating system, since with it we can organize and control the
les and folders of the dierent storage systems at our disposal such as the hard drive, disk drive, etc.
The Windows Explorer is also known as the File Manager. Through it we can delete, see, copy, or move
les and folders.

3.6.1 Starting the Explorer
on the task bar or desktop. If you
The quickest way to start up the Explorer is through the icon
don't already have the icon created, you can open the Explorer as follows:

• Click on Start [U+F0AE] Select All programs [U+F0AE] Select Accessories [U+F0AE] Select Windows
Explorer
• Right click on Start button and select Explore
• From the Start button, choose My documents, My images or My music; the dierence is that in these
cases we will go directly to those folders.

3.6.2 The Explorer's window
The explorer consists basically of two sections. On the left side there is the directory tree, which is the list
of units and folders that we have. Only units and folders appear, no les. On this image we can see a few
folders such as My Documents, aulaclic, ... the My Computer icon, My Network Places and the Recycle Bin.

http://cnx.org/content/m30793/1.1/
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Figure 11

On the right side there is another section, which will show the content of the folder that we have opened
on the left section. This section shows its folders and les. In this case the les that are contained in the
folder WinXP appear. Depending on the type of view that we have activated we will see dierent type of
information regarding the les.
Next we will explain the dierent bars that make up this window.
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Figure 12

The standard bar contains the buttons for the most used operations.
If this bar is not visible select from the menu View, the option Toolbars, next select the option Standard
buttons.

The Back button
will allow us to go to the last page that we have seen. The button
next to it, when activated, allows us to move one page forward.
will allow us to go up one level, which means going back to the folder that contains
The up button
the folder we are working with.
The search button

displays a window where we can search for the le we want.

shows the folder's structure on the left side of the screen, or it can display an
The folders button
area with the most frequent tasks, depending on the le we have selected. In this area we can nd, among
others, the following buttons:
The last button
allows us to change the views on the folders (view details, Thumbnails,...)
We'll explain this in more detailed on the next page.

Figure 13

The Address Bar is well known for Internet because it shows the address of the web we are viewing. With
Windows Explorer it functions the same way, but it shows the name of the folder we are working with.
If we click on the black arrow it will show the structure with our computer's drives.
If we write a name in the address bar and we click on the green arrow, it will search for this name.
Windows explorer allows us to see the folder's information in dierent ways or views to facilitate specic
searching.
Go to the folder you wish to see:

http://cnx.org/content/m30793/1.1/
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a menu with the following options will appear:

Figure 14

Tiles. The les and folders are shown with large images with the name, le type and size in KB; if it is
a picture le the size is shown in pixels. The elements are organized one next to the other from left to right.
Icons. The les are represented with an icon smaller than a tile. The only information shown is the
name of the le. This type of icon is used when the selected folder has an average quantity of elements.
List. Shows small icons, one below the other, so it's easier to search by name. On this view, only the
name of the le or folder appears.
Details. Icons are shown one below the other, with some of their properties. This type of display is used
when we want to nd an element with certain characteristics, such as size, le type, date of modication,
etc.
With this type of view we can organize the elements by size, modication date, name, etc.
For example, to organize by the modication date it is enough to click on the box Date Modied, and it
will arrange the les by date from greater to lesser. If we click on it again it will arrange it from lesser to
greater. The older dates are considered lesser.
On the views List or Details the elements appear one below the other and in the case of deleting or
adding, the elements will reorganize themselves.
Thumbnails . A small representation of the content will appear with the format of the image, such as
jpg., jpeg., bmp., gif., etc.
Filmstrip. This view is only available for images. On the bottom part a strip will appear with the
images in thumbnail format and on the top we will see a larger representation of the image selected on the
bottom.
3.6.3 Opening Files
Choose one of the following ways:

• Double click on the le's icon.
• Right click on the le's icon. Select Open
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• Select the le and press Enter.

3.6.4 Selecting Files
If you wish to select a single le or folder you simply need to click on it. This way any operation you perform
will only apply to the selected le or folder.
If you wish to realize an operation on several les or folders, Windows Explorer will allow you to select
several elements at the same time.

To select consecutive elements

Click on the rst element and then click on the last element while keeping Shift key pressed. This can also
be done with the mouse. To do this, click on the left of the rst element (but not on it) and, without letting
go, drag it. A frame should appear that shows the area that the frame encompasses. Continue dragging
until all the desired elements are within the frame, then let go of the left mouse button..
To select several elements that are not consecutive
Select the rst element and continue to select the desired elements while keeping the Ctrl key pressed.

3.6.5 Creating and Deleting Folders
To create a folder we need to place the pointer where we want the folder to be.Open the folders that we have
by clicking on the + located to the left of the folders.
If we click on the plus sign of a particular folder it will display and show all of the folders contained in it
and the plus sign will become a minus sign -; this will take care of retracting the folders displayed, or hide
the content of the folder selected.
Once we have the folder that we want open we will select it by clicking on the appropriate folder .Open
the menu File, select the option New and then select the option Folder.
Now we can view on the bottom right window a new folder that has the name New Folder. This is the
name that Windows gives new folders by default. In the event that it nds another folder with that same
name, it will subsequently name the new folders New Folder(1), New Folder(2), etc...
The name of the folder can be changed

3.6.6 Deleting folders
To Delete a folder, rst place the pointer on it.
Once the folder has been selected go to the Standard bar and click on or you can use Delete.
When we delete a folder or le, by default Windows will move it to the Recycle Bin. The settings can
be changed so that it deletes it completely.
The Recycle Bin is nothing more than a space reserved on the hard disk so that in case of having deleted
any element it would be possible for us to retrieve it.
Deleting Files
To delete a le we follow the same steps to delete a folder, but instead of selecting a folder select the le
you wish to delete.

3.6.7 Copying Files or Folders
Select the element to be copied.Click on Copy and it will open a dialog box titled Copy Items. If we do not
have this button on the tool bar, we can go to the Edit menu and select Copy to Folder... First select the
item to copy
Search for the folder to which we will copy the selected element. It works like Windows explorer. If we
click on the + that appears on the left, the contents of the folder will be displayed.
Once the folder has been selected, click on Copy.
In the case of not having the folder created to which we want to copy to, click Make new folder, write
the name of the new folder and Click OK.
http://cnx.org/content/m30793/1.1/
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3.6.8 Moving Files or Folders
Moving a le or folder means copying the element to the desired location and then deleting its original
location. The following steps are very similar.

• Select the le or folder you want to move.
• Click on , or Edit > Move to Folder which will open a new window titled Move Items.
• Search for the folder where the element are to be moved to.
• Once the folder is selected, click Move.
• In the case of not having the folder created to which we want to move the information to, simply click
Make New Folder.
• Write the name of the new folder.Click OK.
When moving or copying an item, its name can coincide with the name of a le or folder that is in the
destination folder. In this case Windows will ask if we want to substitute the existing le or folder by the
new one. When folder is moved or copied, its entire content is also moved or copied.

3.6.9 Changing the name of a File or Folder
• Select the le or folder that you want to change the name of.
• With the right mouse button click on it.
• Select Rename from the shortcut menu, then the name of the le or folder will be highlighted and with
the pointer blinking inside the name box.
• Write the new name.
• Click Enter or click outside the le or folder so that the changes take place.
• You can also do this with Rename option from File menu.

3.6.10 Files and Folders Properties
Both les and folders have their own characteristics, for example size, location, date of creation, attributes,
etc.
To know the characteristics of a particular le or folder we need to:

• select it and choose Properties option from File menu,or,
• click on it with the right mouse button and select the option Properties from the menu that is displayed.
Click on the OK button to accept or the Cancel button to discard all changes.
http://cnx.org/content/m30793/1.1/
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3.7 Run a program on Windows
To run a program on Windows, you would do the following steps:

• Click on the Start menu
• Click on the Run option
• Type the name and the directory of the le in the Open eld (or click on Browse button if you do not
know its location)
• Click on the OK button

3.8 The Command Prompt
Before Windows was created, the most common operating system that runs on PC was DOS. Though
Windows does not run on DOS, they do have something called the command prompt, which has a similar
appearance to DOS.

Figure 15

To use the command prompt you would type in the commands and instructions you want and press enter.

3.9 The Recycle Bin
The recycle bin provides a safety net when deleting les and folders. When you delete any of these items
from your hard disk, Windows places it in the Recycle Bin. Items deleted from a oppy disk or a network
drive are permanently deleted and are not sent to the Recycle Bin.
Items in the Recycle Bin remain there until you decide to permanently delete them from your computer.
To delete or restore les in the Recycle Bin
On the desktop, double-click Recycle Bin.Do one of the following:
http://cnx.org/content/m30793/1.1/
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• To restore an item, right-click it, and then click Restore.
• To restore all of the items, on the Edit menu, click Select All, and then on the File menu, click Restore.
• To delete an item, right-click it, and then click Delete.
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